SAP2000 (V24) Frame Analysis Tutorial

The following is a step-by-step procedure for analyzing a two-dimensional frame using SAP2000
(v24). The order of some of these steps is not critical; however, all steps should be completed
before the execution of the analysis. If you have questions or find instructions unclear or
inaccurate, please get in touch with Dr. Charles Camp.

Draw the shear and moment diagrams for each of the three members of the frame. Assume the
frame is fixed and connected at A, B, and D, with a pin joint at C.

Assume E is 200 GPa, A = 20 (10%) mm?, and / is 300 (108) mm?.
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When you start SAP2000 Version 24, you should see the following interface window:

Fie Edit View Define Draw Select Assign Anayze Display Design Options Toak  Help &
Windowl - x|

Use File Menu to Create or Open Mode!

Step 1: New Model - To start a new problem, select New Model under the File menu.

The New Model window gives many different templates for general structures. On this menu,
you can select the units for the problem; the default is kN, m, C. You can change the unit when
necessary, and SAP2000 converts the values. In this example, the units are kN and m. Click on
the 2D Frame icon on the first row of templates.
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New Model Initialization Project Information

O Initialize Mode! from an Existing File
@ Initialize Mode! from Defauit Settings
Defautt Units. KN, mm, C ~

Modify/Show Information

Default Waterials United States ~
Save Options as Default

Select Template

I

Blank Giid Only Beam 2D Trusses 3D Trusses 2D Frames

3D Frames Wall Flat Slab Shells Staircases Storage Structures
Underground Solid Models Pipes and Plates
Concrete




The Frame template menu should appear.

Portal Frame Dimensions

Number of Stories.
Number of Bays

2D Frame Type

Portal ~

D Use Custom Grid Spacing and Locate Origin

Section Properties

Beams | Defautt |+
Columns | pefault v+
Restrainis Cancel

Story Height -60 00

Bay Width |5000

In this example, the frame has one bay of 5,000 mm (5 m) and a one-story height of 6,000 mm

(6 m). Enter the values and click OK.

The SAP2000 interface displays the geometry of the frame. By default, the supports are pins.
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Since we do not need a 3-D view of the frame, click on the window label and delete the left-

hand side window so that you have an xz view of the frame.
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This example’s grid lines are unimportant, so they are turned off. Click on the View menu at the

top of the SAP2000 interface and then Show Grid.

Next, adjust the height of the left column. Select the bottom node of the element by clicking on
the joint with the pointer. A blue “X” should appear at the joint to indicate it is currently
selected. Select the Edit menu at the top of the SAP200 interface, then Move, and the following
menu appears. In this example, the node moves in the positive z-direction 2,000 mm (2 m).

S| S|
Change Coordinates by: Change Coordinates by:
Delta X 0 mm Delta X 0
Delta ¥ 0 mm Delta ¥ 0
Delta Z 0 mm Delta Z 2000

‘ Pick Two Points on Model |

‘ Reset Form to Default Values |

| 0K | | Close ‘ | Apply |

| Pick Two Points on Model |

| Reset Form to Default Values |

mm

mm

mm
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Step 2: Define Structural Supports - To define the location and type of structural support,
select the support location by clicking on the joint with the pointer. A blue “X” should appear at
the joint to indicate it is currently selected. Next, click on the Assign tab at the top of the
SAP2000 interface, then click on Joint, and then the Restraints ... button on the bottom
toolbar.

S
Restraints in Joint Local Directions
Translation 1 [] Rotation about 1
Translation 2 [] Rotation about 2
Translation 3 [] Rotation about 3

Fast Restraints

‘ OK | | Close ‘ Apply

The Assign Joint Restraints menu appears as shown. Usually, the directions 1, 2, and 3 listed on
the menu correspond to the x, y, and z directions. The Fast Restraints buttons may be used for
most problems when working on two-dimensional structures. If the support conditions for your
problem are not listed in the Fast Restraints section of the menu, you should select the
appropriate combination of restraints.



In this frame example, the support at A and D are fixed.

Select the bottom nodes with the pointer (an “X” should appear at the joint), then click

the Fixed button and then OK. After the supports have been defined, the frame problem
should appear in the SAP2000 interface window as follows:
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To model the pin connection at node C, select the frame element and click on Assign, Frame,
and Releases/Partial Fixity. The following menu appears.

a8
Frame Releases
Release Frame Partial Fixity Springs
Start  End Start End
Axial Load O O
Shear Force 2 (Major) O O
Shear Force 3 (Minor) O O
Torsion O O
Moment 22 (Minor) O O
Moment 33 (Major) 0 0 kN-mm/rad

Clear All Releases in Form ‘

Check the box for Release End Moment 33 (Major). The moment at the end of this element are
zero. SAP2000 indicates that a release has been specified with a green dot and shows a break
on the line.
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Step 3: Apply Forces — Two loads are applied to the frame in this example.

The top frame element has two equally spaced point loads, and the right-side column has a
distributed load.

To apply the point loads, select the frame element with the pointer, click on Assign, then Frame
Loads, and then Point. The following menu appears. Click on Absolute Distance from End-I and
enter the position and value of the two point loads. This example shows a 50 kN load at 1,500
mm (1.5 m) and a 40 kN load at 3,500 mm (3.5 m) from the left edge.
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General Options General Options
Load Pattern DEAD - () Add to Existing Loads Load Pattern DEAD - () Add to Existing Loads
T SET GLOBAL - @ Replace Existing Loads Tt eCEmT GLOBAL ~ @ Replace Existing Loads
e Fan - O Delete Existing Loads [ ———— Ty ) Delete Existing Loads
Load Type Force Load Type Farcz

Point Loads Point Loads

1 2 3 4 1. 2 3 4

Relative Distance  © 025 075 1 Absolute Distance  |1500 3500 0 0 mm
Loads 0 0 0 0 s Loads s0 40 0 0 KN
®) Relative Distance from End-I O Absolute Distance from End-1 ) Relative Distance from End-1 ® Absolute Distance from End-|

|
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Click OK, and the loads are displayed on the frame:
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Next, click on the far right element and select Assign, Frame Loads, and Distributed. The
following menu should be displayed. In this example, the distributed load is in the negative
local x-direction and has a value of 0.015 kN/mm (15 kN/m). Enter these values into the menu

and click OK.

General Options General
Load Pattern DEAD © Add to Existing Loads Load Pattern
Coordinate System GLOBAL Q) R EE Eay ik Coardinate System
O Delete Existing Loads
Load Direction EEr 9 Load Direction
. Froe Uniform Load o
0 kip/in
Trapezoidal Loads Trapezoidal Loads
1 2 3 4
Relative Distance 0 025 0.75 1 Relative Distance
Loads. 0 0 0 0 kipfin Loads

) Absolute Distance from End-1

Reset Form to Default Values

[ok | [cose | [ aeay |

(®) Relative Distance from End-l

(®) Relative Distance from End-I

0
0

Options
DEAD ) Add to Existing Loads
GLOBAL @ Replace Existing Loads
X " ) Delete Existing Loads
Fr Uniform Load
0015 KN/mm

1 2 3 4

025 075 1

0 0 0

kN/mm

O Absolute Distance from End-|

Reset Form to Default Values

The distributed loading is displayed on the frame.
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The point loads are not deleted; they are currently not displayed. Select Display, Show Object Load
Assigns, Frame, and then OK to see all frame loads.

S]

File Edit View Define Draw Select Assign Analyze Display Design Options Tools Help k2
D HE9e /a»r0hagaeaq @ledayxxyzw ded 4§ 555 Niitt-na-; I-/@-E-|-
J Frame Span Loads (DEAD) (GLOBAL CSys) | - x

—
=)
N
o1
N
s
X !
(5]
[} —]
r=1
o}
L
7 ]
W
A
4 e—
052
[N
al
Ps
S
XZ Plane @ Y=0 4 | & GLOBAL v [kN,mm,C

Step 4: Set Analysis Options - This example models the frame in the x-z plane. Click on

the Analyze menu at the top of the SAP2000 interface window and then click Set Analysis
Options to limit analysis to variables in the x-z plane. The Analysis Options menu appears as
follows:



Available DOFs

Mux Mur [Fluz R M RY [ RZ

Fast DOFs

Space Frame Plane Frame Plane Grid Space Truss

J I IT A A r ! g

XZ Plane XY Plane

Tabular File

Modify/Show Automatic Tabular Output Data...

No files specified for automatic tabular output

Advanced SAPFire Options. ..

Cancel

To restrict SAP2000 to variables in the x-z plane, select the Plane Frame button and click OK.

Step 5: Define Material Properties - SAP2000 assumes the loads acting on a structure, including
the weight of each element. In our frame analysis, we assume that each element is weightless.
To define the properties of a material, select the Define menu at the top of the SAP2000

interface window and then click on Materials. The Define Materials window appears as shown
below:

Materials Click to:

4000Psi Add New Material...

ABS2Fy50
Add Copy of Material...

Modify/Show Material...

Delete Material

[] show Advanced Properties

Cancel

On this menu, you can change the properties of materials. Select the A992Fy50 (steel with a
yield stress of 50 ksi) material in this example and click the Modify/Show Material... button.

The Material Property Data window is displayed.
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General Data General Data
Material Name and Display Color . Material Name and Display Color .
Waterial Type Steel Material Type Steel
Material Grade [Grade s0 | Material Grade [Grage s0 |
Material Notes. Modify/Show Motes. Material Notes Modify/Show Notes.

‘Weight and Mass Units. Weiaht and Mass Units
Weight per Unit Volume KN, mm, C v ‘Weight per Unit Volume I:I KN, mm, C ~
Mass per Unit Volume 7.849E-12 Mass per Unit Volume 0.

Isotropic Property Data Isotropic Property Data
Modulus Of Elasticity, E Modulus Of Elasticity, E 200
Poisson, U Poisson, U 03
Coefficient Of Thermal Expansion, A Coefficient Of Thermal Expansion, A
Shear Modulus, G 76.9031 Shear Modulus, G 76.8031

Other Properties For Steel Materials Other Properties For Steel Materials
Winimum *ield Stress, Fy Minimum *igld Stress, Fy
Winimum Tensile Stress, Fu Minimum Tensile Stress, Fu
Expected ield Stress, Fye Expected Yield Stress, Fye
Expected Tensile Stress, Fue Expected Tensile Stress, Fue

D Switch To Advanced Property Display D Switch To Advanced Property Display
Cancel Cancel

Change the Weight per unit Volume value to zero and adjust the Modulus of Elasticity, E, to
200 kN/mm? (200 GPa). Click OK to return to the Define Materials window, then click OK again.
Now, we have a material named A992Fy50 that has no weight per volume. For this example
problem, the default values for the Mass per unit Volume, Modulus of elasticity, Poisson’s ratio,
and the Coefficient of Thermal Expansion can be used. For most linear elastic statically loaded
structures, only values for Weight per unit Volume and Modulus of Elasticity are required.

Step 6: Define Frame Sections - To define the cross-section properties of a structural element,
click on the Define menu at the top of the SAP2000 interface window, then click on Section
Properties, then Frame Sections..., and then the Frame Properties window is displayed.

Properties Click to

Find this property: Import New Property.

FSEC1

FSEC1 Add New Property:
Add Copy of Property.

Modify/Show Froperty.

The default Frame Section label is FSEC1. To change the properties of the frame section, click
on the Modify/Show Property... button. The I/Wide Flange Section window is displayed.
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Section Name FSEC1 Display Color
Section Motes Modify/Show Motes...
Dimensions Section
Outside height (t3 )
Top flange width (t2 ) l:l S
Top flange thickness (if) 038
Web thickness (tw )
Bottom flange width (t2b ) l:l e
Bottom flange thickness (tfb ) 038
Fillet Radius Properties
Section Properties...
Material Property Modifiers Time Dependent Properties..
+ A99ZFy50 ~ Set Modifiers.
Cancel

To define the material of this frame section, click on the Material pull-down menu and select
our weightless material A992Fy50. Click OK to return to the Frame Properties window, then

click OK again.

In this example, the frame elements have a cross-sectional area of A =20 (103) mm? and a

moment of inertia value / = 300 (10%) mm®. Click Add New Property on the Frame Properties
menu to specify this value. The Add New Property menu is displayed. For this example, click the
Frame Section Property Type dropdown menu, select Other, and then click on General.

S|

Select Property Type

Frame Section Property Type Steel

Click to Add a Steel Section

L

1/ Wide Flange

nn

Double Angle

]

Rectangular

[ T L

Channel Tee Angle

Ir o O

Double Channel Pipe Tube

O 1

Circular Steel Joist

Auto Select List

Cancel
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Select Property Type

w Frame Section Property Type Other v

PEolio Ao oo

¢

General

I

Nonprismatic

®

Section Designer

Cancel

The Property Data menu is displayed. In this example, the Moment of inertia about the 3 axis
(the strong axis) is 300 (10%) mm?. The value of the Cross-sectional area is 20 (10°) mm?. The
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Moment of inertia about the 2 should be a small value of 1 to minimize their effect on the
results.

Section Name FSECZ

Dramartias

Cross-section (axial) area Section modulus about 3 axis (top) [
Noment of Inertia about 3 axis 300000000 Section modulus about 3 axis (bottom)  [1. |

Moment of Inertia about 2 axis. 1 Section modulus about 2 axis (left) l:l
Product of Inertia about 2-3 o] Secton modulus about 2 axis (right) ]
Torsional constant [t ] warping Constant (Cw) o]
Shear area in 2 direction [ 1 Piasticmoduls about 3 axis 1
Shear area in 3 direction [t ] Pasticmodulus about 2 axis ]
CG offset in 3 direction l:l Radius of Gyration about 3 axis. l:l
CG offset in 2 direction 0] Radus of Gyration about2 axis ]
Shear Center Offset (x3) o]

Shear Center Offset (x2)* o] - vaueisnotused nanaysis

Cancel

Enter the value and click OK. Then click OK on the General Shapes menu, and the Frames
Properties menu is displayed. Note that FSEC2 has been added to the list of sections. Click OK.

Properties Click to

Find this property: Import News Property...
[Fseca |
[rmrns 1 Add New Property..

N

Add Copy of Property...

Modify/Show Property..

Cancel

Step 7: Assign Frame Sections - To assign the frame properties of a structural element, select
all frame elements with the pointer and click on the Assign menu at the top of the SAP2000
interface window, then click Frame, and then Frame Sections. You can assign the same section
properties to multiple elements by selecting all the elements that share the same properties.
Choose the FSEC2 frame element from the Assign Frame Sections window and click OK.
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The frame section name is displayed next to each element selected. After the frame sections
have been assigned, the SAP2000 interface window is displayed.
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Step 8: Run Analysis - To analyze the model, press the Run Analysis button P . The Set Load
Cases to Run menu is displayed.

Click to:
Case Name Type Status Action
DEAD Linear Static Not Run Run
MODAL Modal Not Run Do not Run
Run/Do Not Run All
Delete All Results
Show Load Case Tree...
Save Named Set
Analysis Menitor Options. Show Messages after Run D Model-Alive
O Newver Show @ If Errors or Warnings
® Show After I:I seconds O Always oK Cancel
L 1

By default, there are two load cases: DEAD and MODAL. More load cases can be added, but
only the DEAD load case is required for this example. Click on the Run Now button. If the
analysis is successful, the Analysis Complete window is displayed and reports that the analysis
is complete. Click OK, and the Save Model File As window is displayed.
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A [ ThisPC »

Local Disk () » camp »

Coursework > CIVL4122 »

SAP200 > Chapter 11 v o Search Chapter 11
Organize New folder - o
22 Dropbox A Name Date mociified . size
[ Desktop H Beam _tutorial.sdb 10Ke
o Creative Cloud Files H eomple 110-55b ke
22 Dropbox H quiz5423.5db 10KB
@ OneDiive H uiz 72 f23.5db 10KB
@ OneDrive - The University of Memphis
& Charles Camp (cveamp)
@ ThisPC
J 3D Objects
[ Desktop
[ Documents
& Downloads
D Music
=] Pictures.
18 Videos
i, Local Disk (C)
= cvcamp (Vitnas\uomhomes) (W)
= civil (\itnas.uom.memphis.edu\group:
= cveamp (\itnas.uom.memphis.cdutuo
T Libraries .
File name: | Beam_tutorial sdb )
Save as type: | SAP2000 Model Files (*.sdb) v
~ Hide Folders Save Cancel

When you run a model, SAP2000 creates about 40 temporary files, so choosing a particular
folder to store the SAP2000 files is beneficial. The Windows Desktop is not a good location.
When a folder is selected, name the SAP2000 model file.

In this example, the file name is frame_tutorial. SAP2000 saves the model information in the
file named frame_tutorial.sdb in the folder selected. The SAP2000 interface window displays
an exaggerated deflected shape of the modeled structure.
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Step 9: Print Frame Forces - To get a quick feel for the relative magnitude of the forces in the
frame, click on the Show Forces/Stresses pull-down menu - at the top of the SAP2000
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interface, select Frames/Cables/Tendons..., and the Display Frame Forces/Stresses menu is
displayed.

Case/Combo

Case/Combo Name pET

Multivalued Options

Envelope (Max or Min)

® Step =
Display Type

@ Force O Stress
Component

) Axial Force O Torsien

) Shear 2-2 O Moment 2-2

) Shear 3-3 ® Moment 3-3

Scaling for Diagram
(@ Automatic
) User Defined
Options for Diagram

@ Fill Diagram ) Show Values

‘ Reset Form to Default Values |

‘ Reset Form to Current Window Settings |

‘ 0K ‘ | Close | | Apply ‘

Select Moment 3-3 (the strong axis) and then OK; the bending moment along the frame is
displayed.

Is]
| File Edit Define Draw  Select Assign Analyze Display Design Options Tools  Help k3
(DO EHG 9« Ala» D QaaQRa @y xyzw de 4§52 5 - nfttnel-i T-1@-0--

E Moment 3-3 Diagram (DEAD)

Right Click on any Frame Blement for detalled diagram &+ i | GLOBAL ~ KN,mm,C  ~
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For the shear force, Select the Shear-22 and then OK; the shear force along the frame is
displayed.

iB AP2000 v24.2.0 Ultimate 64-bit - frame_tuto - [}

| File Edit View Define Draw Select Assign Analyze Display Design Options Tools Help k3

DV BE&2 ¢ A@r DR aQaaaa Wilayeyzw H6d 4§55 - Driteoe |- I -0 -0 -
- X

; | [ ShearForce 2-2 Diagram (DEAD) |

2

Right Click on any Frame Blement for detalled diagram &+ i GLOBAL ~ KN,mm,C  ~

The default view is the Fill Diagram, where the relative magnitude of the moments are
displayed. Negative bending moments are in red, and positive in blue.

Another way to display force information is to unclick Fill Diagram and click on Show Values on
Diagram. In this case, the value of each axial force is displayed next to the elements.
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To view more detail about the forces along an element, click on the element in the SAP2000
interface and right-click. The Diagram for Frame Object # (FSEC2) window is displayed. Below
are the results for each of the three elements in this example.

B vizg Frame ® ®
End Length Offset Display Options End Length Offset Display Options
Locati Locati
Case |DEAD v (Locaton) 4 O Scrol for Values Case | DEAD {tocston) . » O scrol for Values
tems | Major (V2and M3) ~ | Single valued FEnd: | 0. mm @® Show Max tems | Major (VZand W3) v | Single valued FEnd: | 0. mm ® Show Max
(0. mm) | (0. mm)
Jt 2 Jt 4
JEnd g mm JEnd 0 omm
| (4000, mm) (5000. mm)
Equivalent Loads - Free Body Diagram (Concentrated Forces in KN, Concentrated Moments in KN-mm) | Equivalent Loads - Free Body Diagram (Concentrated Forces in KN, Concentrated Woments in KN-mm)
- Dist Load (2-dir) Dist Load (2-dir)
105883 5 2078.33 2078.33 50 40
0. KN/mm ‘ 1, ‘1 0. KN/mm
C ‘l D at 4000. mm | C at S000. mm
26.9 Y500  Positive in-2 drection ‘ 474 2258 Posiive in-2 direction
E——— FesuRan S
Shear V2 Shear V2
-26.99 KN | _ 47416 KN
Resulant Moment Resultant Homent
| Moment M3 | Moment M3
Deflections Deflections
Deflection (2-dir) Deflection (2-dir)
/—\ 1730085 mm 2.039627 mm
at 2000. mm - at 2500. mm
Positive in 2 direction \_/ Positive in -2 direction
(O Absolute () Relative to Beam Minimum @ Relative to Beam Ends (O Absolute () Relative to Beam Minimum @ Relative to Beam Ends
Reset to Iniial Units Unts  KN,mm, €~ Reset o ntial Units Units KN, mm, €~

Sk X
End Length Offset Display Options
Location
Case |DEAD ~ ( ) it 3 (O scroll for Values
fems | Major (VZand M3) | Single valuied - End: | 0. mm @ Show Max
(0. mm)
4
J-End: | 0.mm
(6000. mm)
| Equivalent Loads - Free Body Diagram (Concentrated Forces in KN, Concentrated Moments in KN-mm)
| Dist Load (2-dir)
| 1080
| 0.015 KNimm
| Q at 3000. mm
| 63.0 Iﬁ 99 Positive in -2 direction
resutam snear
Shear V2
‘ “E{
7—' at 0. mm
Resuttant Moment
Moment M3
— at0. mm
Defiections
Deflection (2-dir)
/\ -0.677143 mm
at 3000. mm
Posttive in -2 direction
(O Absolute (O Relative to Beam Minimum (® Relative to Beam Ends.
Reset fo Inital Unts unts | KN,mm,C v

Drag the vertical slider along the element to see values on the loads, shear, moment, and
deflection.
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To print the results to a file, click the File menu, select Print Tables..., and display the following
menu.

Edit

| 3
=-C] MODEL DEFINITION (D of 54 tables selected) Load Patterns (Wodel Det.)

|

| 0] System Data Select Load Patterns...
+|:| Property Definitions A
+-[] Lead Pattern Defintions
+I:| Other Definitions Load Cases (Results)
+|:| Load Case Defintions e
+-[] Connectivity Data
-1 Joint Assignments 10f1 Selected
+-[] Frame Assignments
+|:| Options/Preferences Data Wodify/Show Options. ..
+-[] Miscellaneous Data

E ANALYSIS RESULTS (1 of 10 tables selected)
-] Run Information Output Type
+-J Joint Qutput

i (@) RATF File
=B Element Output O TXTFie
| EB Frame Ouput () TXT File wio Splits
i--[4 Table: Element Forces - Frames §
() HTML File

[ Table: Element Stresses - Frames
[ Table: Element Joint Forces - Frames Options
¢ @+ Objects and Elements
-0 Structure Output

Print to File

Print Landscape
Fitter Criteria
Hyperlinked Contents

OooE

Mamed Sets

Save Named Set...

I oK | Cancel

Table Formats File... Current Table Formats File: Program Default

In this example, we want the shear forces and bending moments in the frame, so click on
expand the Element Output item under the ANALYSIS RESULTS section, expand the Frame
Output item, and then click on Tables: Element Forces - Frames. Also, click on the box Print to
File and the TXT file button to define the file format. Click OK and define the name and location
of the TXT file.

There is an option for Spreadsheet Format if desired. The default location for the file is the
same directory as the problem files. A different location can be specified by clicking File
Name and choosing the desired file location and name.

Turn on the frame labels to correlate the results printed in the output file to frame elements in
the structure. Click the Show Undeformed Shape button / on the main interface to display the

frame element labels. Next, click on the Display Options button and under
the Frame section of the menu, click on Labels.
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The frame element numbers or any other information displayed in the main SAP2000 interface
can be printed by clicking on the File menu and selecting Print Graphics (the image is sent to
the default printer).

The results of the frame analysis presented in the output file are listed by frame element
number.

frame_tutorial sdb SAP2000 v24 2.0 - License #2008*1H34P5URBAAEDPF
08 Movember 2023
Table: Element Forces - Frames, Part1 of 2
Table: Element Forces - Frames, Part 1 of 2
Frame Station OutputCase CaseType P v2 V3 T M2
mm KN KN KN KN-mm KN-mm
1 0. DEAD LinStatic -47.416 -26.99 0 0. 0.
1 2000 DEAD LinStatic -47.416 -26.99 0 0 0
1 4000. DEAD LinStatic -47.416 -26.99 0 0. 0.
2 0. DEAD LinStatic -42.584 -63.01 0 0. 0.
2 3000. DEAD LinStatic -42.504 -18.01 0 0. 0.
2 6000. DEAD LinStatic -42.584 26.99 0 0. 0.
3 0 DEAD LinStatic -26.99 A7 416 0 0 0
3 500. DEAD LinStatic -26.99 -47.416 0 0. 0.
3 1000. DEAD LinStatic -26.99 -47.416 0 0. 0.
3 1500 DEAD LinStatic -26.99 A7 416 0 0 0
3 1500. DEAD LinStatic -26.99 2584 0 0. 0.
3 2000. DEAD LinStatic -26.99 2584 0 0. 0.
3 2500. DEAD LinStatic -26.99 2584 0 0. 0.
3 3000. DEAD LinStatic -26.99 2584 0 0. 0.
3 3500 DEAD LinStatic -26.99 2584 0 0 0
3 3500. DEAD LinStatic -26.99 42584 0 0. 0.
3 4000. DEAD LinStatic -26.99 42584 0 0. 0.
3 4500 DEAD LinStatic -26.99 42504 0 0 0
3 5000. DEAD LinStatic -26.99 42584 0 0. 0.
Table: Element Forces - Frames, Part 2 of 2
Table: Element Forces - Frames, Part 2 of 2
Frame Station OutputCase M3 FrameElem ElemStation
mm KN-mm mm
1 0. DEAD -105883.47 1-1 0.
1 2000. DEAD -51902 57 1-1 2000.
1 4000. DEAD 2078.33 1-1 4000.
2 0 DEAD -108057 31 241 0
2 3000. DEAD 13471.34 21 3000
2 6000. DEAD 0 21 6000.
3 0. DEAD -2078.33 31 0.
3 500. DEAD 21629.51 3+ 500.
3 1000 DEAD 4533734 31 1000
3 1500. DEAD 69045.17 31 1500.
3 1500. DEAD 6904517 3+ 1500.
3 2000 DEAD 67753 3 2000
3 2500. DEAD 66460.84 3+ 2500
3 3000. DEAD 65168.67 3+ 3000.
3 3500. DEAD 63876.5 31 3500
3 3500. DEAD 63876.5 3+ 3500
3 4000 DEAD 4258433 31 4000
3 4500. DEAD 2129217 31 4500
3 5000. DEAD -3.228E-11 3+ 5000.
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Note that SAP2000 lists the variation of the internal forces and moments along the element.
For frame analysis, there are bending moments and shear forces. The values in the “M3” are
the bending moments, and “V2” are the shear forces.
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